
IV. Дизайн и проектирование самосборки и  

самоорганизации неравновесных наносистем  

с помощью модуля «НаноТрансформеры» 

Целью работы является выявление особенностей и 

различий структурной организации  фазовых превращений 

металлических нанокластеров с ГЦК и ОЦК типами атомных 

упаковок. При выполнении лабораторной работы 

предполагается знакомство с интерфейсом и базовыми 

возможностями программ семейства «NanoEvolver», 

приобретение навыков работы и расчетов в данной программной 

среде. 

Общий план работы. В ходе выполнения компьютерных 

экспериментов планируется 

1. Проведение моделирования процессов структурной 

реорганизации нанокластеров с ГЦК или ОЦК типом 

атомной упаковки в различных температурных режимах (на 

примере нанокластера Ni172  или Fe189); 

2. Проведение моделирования процессов структурной 

реорганизации нанокластеров с полной перестройкой типа 

атомной «укладки» в системе (на примере ГЦК → ГПУ 

превращений никеля). 

Порядок выполнения работы 

1. Запустить программу «NanoEvolver» — Dissipative (версия 

4.2). При необходимости расположите окно программы и 

окно справки на экране так, чтобы обеспечить себе удобство 

чтения настоящего руководства к лабораторной работе и 

выполнения инструкций в окне «NanoEvolver». 

2. Начальный вид окна программы прост, и главное меню пока 

не предоставляет доступа к большинству имеющихся 

команд. Первое внимание обратите на команду Index меню 

Help (см. рис. 16). Эта команда (а также назначенная ей 



«горячая» клавиша F1) открывает общее стандартное 

руководство по работе с программами семейства 

«NanoEvolver». Несмотря на то, что в инструкции к 

выполнению лабораторных работ достаточно ясно расписан 

порядок прохождения этапов подготовки и проведения 

расчетов, тем не менее, назначение и смысл некоторых 

параметров и опций в ходе работы поясняться не будет в 

силу ограниченности отведенного времени. При 

возникновении острой необходимости, попытайтесь 

обратиться к стандартному руководству и найти 

интересующую вас информацию там. 

 
 

Рис. 16. Начальный вид главного окна программы «NanoEvolver». 

Выделена команда Index из пункта Help главного меню 

3. Загрузите из внешнего файла модель структуры кубического 

кластера никеля. Загрузка осуществляется посредством 

команды Load structure… из меню File. В диалоговом 

окне открытия файла найдите директорию Structures и в ней 



— файл Ni172_cube.hin (см. рис. 17). Нажмите в диалоге 

кнопку Открыть
1
. 

 
 

Рис. 17. Выбор структуры для загрузки в диалоговом окне открытия 

файла 

Внимание! По умолчанию «NanoEvolver» использует графовое 

представление структур, отрисовывая только ребра графа 

(межатомные связи), на пересечении или концах которых 

находятся вершины графа — ядра атомов. Для компактности 

хранения на диске HIN-файлы металлических структур (типа 

                                                 

1
   

При появления данного сообщения необходимо открыть файл 

Ni172_cube.hin с помощью программы Блокнот и заменить все «,» на 

«.» (Правка  Заменить  Что , Чем .  Закрыть  Сохранить 

изменения) 



кластеров никеля) и некоторых других содержат информацию 

только о координатах ядер атомов частицы. В связи с этим 

обстоятельством после загрузки структуры кластера никеля 

внешний вид окна программы не изменяется. Эта особенность 

не должна смущать пользователя по той причине, что по 

желанию пользователя же в программах семейства 

«NanoEvolver» структура связей может быть задана вручную, 

как будет указано ниже. Для всех иных случаев граф связей 

отрисовывается линиями в трехмерном виртуальном рабочем 

пространстве. 

4. Вызовите команду Graph… из меню View. Задайте радиус 

обрезки, заведомо превышающий расстояние между 

наиболее удаленными атомами в структуре, например, 

1000000 a0. (Обратите внимание на то, что в окнах настроек 

«NanoEvolver» используются атомные единицы длины.) Для 

этого в поле Maximum введите 1000000, затем введите 

1000000 в поле Exact value и обязательно нажмите 

Enter для применения изменений (см. рис. 18). При этом в 

главном окне должен отрисоваться полный граф 

наноструктуры. Закройте окно Graph нажатием кнопки OK. 

 
 

Рис. 18. Окно «Graph» и задание радиусов обрезки 



5. Используемая в данной работе версия «NanoEvolver» 

обеспечивает неизменную степень связности графа 

наноструктуры. Для фиксирования графа вызовите команду 

Lock graph из меню Edit и в ответ на запрос о 

подтверждении нажмите Yes. 

6. Смените способ представления структуры с графового на 

шаровое. Для этого из меню View вызовите команду 

Performance… и в появившемся одноименном окне 

выставьте настройки, как показано на рис. 19. Ползунком 

Sphere radius задайте максимальный радиус атомов-

сфер. 

 
 

Рис. 19. Окно «Performance» и установка шарового представления 

модели 

7. Расположите модель на экране так, чтобы обеспечить 

удобство ее обзора. Используйте клавиши ←↑↓→ для 

вращения модели в пространстве; Insert/Delete — для 

приближения/отдаления; Page Up/Page Down — для 

перемещения по вертикали; Home/End — для перемещения 

по горизонтали. (С зажатой клавишей Shift вы с тем же 

успехом можете управлять положением модели, используя 



манипулятор мышь.) Рассмотрите тип упаковки атомов на 

гранях нанокластера. 

 
 

Рис. 20. Вид модели нанокластера никеля Ni172 в окне «NanoEvolver» 

8. В «NanoEvolver» используются аппроксимирующие парные 

потенциалы в форме функции Морзе. Параметры 

потенциалов — D0 (энергия диссоциации), R0 (равновесное 

расстояние) и ω (частота колебаний).  В данной работе 

расчеты параметров потенциала связи Ni—Ni в нанокластере 

выполнены методом нелокального функционала плотности в 

пакете программ «Winbond». Указание параметров 

потенциалов, а также некоторых важных опций и 

параметров, влияющих на ход расчетной процедуры, 

производится в диалоговом окне Settings (см. рис. 21), 

вызвать которое можно с помощью команды Set 

parameters… меню Edit. 



 
 

Рис. 21. Диалоговое окно выставления опций и параметров 

потенциалов 

Установите параметры, как показано на рис. 6. Параметры 

межатомных потенциалов введите, нажав на кнопку Load 

parameters…, загрузите эти данные из внешнего файла 

параметров Potential_params.txt, который расположен в той же 

папке, что и загруженная структура. Измените запятые в 

введенных данных на точки! Нажатием кнопки OK закройте окно 

Settings с применением всех изменений. 

9. Сохраните отчет во внешнем файле. Для этого вызовите 

команду Save report as… из меню File. Укажите путь 

и разумное имя файла (например, Ni172_1.htm), нажмите 

Сохранить. «NanoEvolver» сохраняет отчеты в удобном 

формате гипертекста, можете сейчас просмотреть 

сохраненный на диске отчет, используя любой 

установленный на компьютере браузер. Анализируя отчет, 

обратите внимание на единицы измерения и порядок 

величин.  



10. Вернитесь к окну «NanoEvolver». Выполните оценку 

ближнего порядка в начальной идеальной структуре 

нанокластера. Начальные характеристики (например, радиус 

первой координационной сферы) кластера соответствуют 

таковым для макроскопического объемного кристалла Ni. 

Оценить ближний порядок позволяет парная 

корреляционная функция, или радиальная функция 

распределения g(R). Равновесные параметры массивной 

кристаллической системы отличаются от параметров 

кластерных потенциалов, найденных в расчете ab initio, что 

может являться причиной небольших различий в положении 

пиков радиальной функции распределения в обоих случаях. 

Более важны, однако, сведения о ширине и 

пространственном разделении максимумов. Средства 

расчета и построения функции g(R) доступны при вызове 

команды Radial distribution function… из меню 

Analysis (см. рис. 22). 

 
 

Рис. 22. Радиальная функция распределения «идеального» 

нанокластера никеля Ni172 



Начальные настройки окна Radial distribution 

function требуют корректировки в конкретном 

рассматриваемом случае. Укажите все необходимые параметры 

как показано на рис. 22. 

Нажатием на кнопку Save image… сохраните 

графическое изображение для последующего сравнительного 

анализа (либо скопируйте в буфер обмена при помощи кнопки 

Copy image и вставьте в документ, если вы пишете отчет). 

Закройте окно Radial distribution function. 

 

11.  
Рис. 23. Окно с кратким отчетом при завершении расчетной 

процедуры 

Раскройте меню Edit главного окна программы «NanoEvolver» 

и выберите пункт Evolve. Данная команда запускает 

вычислительную процедуру моделирования самоорганизации 

исследуемой наносистемы. Результатом процедуры 

самоорганизации является неравновесное, но стационарное 

состояние, самоподдерживающееся на протяжении бóльшей 

части эволюции. По завершении первой процедуры расчетов 

оцените визуально изменения, произошедшие в геометрии 

нанокластера. Отметьте (запомните или запишите) текущее 



значение полной энергии связи. Информацию об этих 

параметрах можно видеть в окошке Report (рис. 23).  

12. Итак, вами получен продукт низкотемпературной 

самоорганизации металлического нанокластера Ni172. 

Исследуйте форму кластера. (Как вы помните, можно 

вращать и двигать структуру в виртуальном пространстве, 

используя клавиши ←↑↓→, Insert/Delete, 

Page Up/Page Down, Home/End, либо мышь (с зажатой 

клавишей Shift).) Как изменился характер упаковки 

атомов на поверхности наночастицы по сравнению с 

первоначальным неравновесным нестационарным 

состоянием? Сохраните отчет (File → Save report 

as…), назвав файл, например, Ni172_100K.htm.  

13. Постройте парную корреляционную функцию (Analysis 

→ Radial distribution function…) для 

«финальной» структуры нанокластера, используя те же 

настройки, что и прежде. Для сравнения можете открыть 

ранее сохраненное изображение графика функции для 

начального состояния.  

14. Сохраните на диск результат своих расчетов — саму модель 

нанокластера. Для этого из меню File вызовите 

инструкцию Save structure…. В появившемся 

диалоговом окне сохранения файла укажите понятное имя, 

например, как и для отчета, Ni172_100K.hin, а из 

выпадающего списка типа файла выберите HC files 

(*.hin) [empty graph] (см. рис. 24). Как вы помните, 

полный граф нанокластера может быть легко восстановлен 

при необходимости продолжения работы в последующем. 



 
 

Рис. 24. Сохранение модели нанокластера никеля Ni172 с пустым 

графом связей 

15. Повторить расчеты для 1000К и 3000К по аналогии с 

предыдущим (рис. 25,26). 

 
 

Рис. 25. Диалоговое окно выставления опций и параметров 

потенциалов. Выставлены параметры для быстрого плавления 

нанокластера 

 



 

 
 

Рис. 26. Оплавленный в жестких условиях нанокластер Ni172 

 

16. Закрепите полученные навыки работы с программой, 

самостоятельно по аналогии проведя расчет для системы с 

ОЦК типом упаковки. Для этого из той же папки structures 

загрузите файл Fe189.hin. Используйте следующие 

параметры аппроксимирующих потенциалов Fe—Fe: 

D0 = 0.5276 эВ; R0 = 5.4161 a0; ω = 160.2397 см
−1

 (указанные 

параметры вводятся с клавиатуры). 

 

МОДЕЛИРОВАНИЯ ПРОЦЕССОВ СТРУКТУРНОЙ 

РЕОРГАНИЗАЦИИ НАНОКЛАСТЕРОВ С ПОЛНОЙ 

ПЕРЕСТРОЙКОЙ ТИПА АТОМНОЙ «УКЛАДКИ» В  

СИСТЕМЕ  

(НА ПРИМЕРЕ ГЦК → ГПУ ПРЕВРАЩЕНИЙ НИКЕЛЯ) 

 

 

17. Загрузите из файла Ni363_angle.hin модель нанокластера, 

оформленного в виде уголка ∟. Как вы заметите сразу после 

загрузки, данная структура в отличие от предыдущих 



случаев сохранена вместе с графом связей, который в свете 

упоминаемой выше дифференциации является первичным 

(prime) графом. Задания extra-графа для этой модели не 

требуется, поэтому сразу зафиксируйте граф, вызвав, как 

обычно, команду Lock graph из меню Edit. 

 

 

18. Переключите способ отображения на шаровую модель 

(View → Performance… → Spheres) и подберите 

желаемый диаметр «атомов». 

 
 

Рис. 27. Начальная геометрия «уголка» Ni363. Упаковка атомов — ГЦК 

типа 

19. Выставьте параметры в окне Settings по примеру на 

рис. 28. 



 
 

Рис. 28. Диалоговое окно выставления опций и параметров 

потенциалов для «уголка» Ni363 

20. Сохраните отчет на диск и откройте его в браузере.  

21. Запустите расчетную процедуру (Edit → Evolve).  

22. По завершении первого цикла расчетов оцените изменения, 

затронувшие геометрию нанокластера. Наблюдаете ли вы 

эффект реорганизации структуры с изменением типа 

атомной укладки? Откройте окно Settings, уменьшите 

температуру до 200 K. Проведите с этими параметрами 

дополнительный расчет. После этого еще уменьшите 

температуру до 100 K и с помощью завершающего 

контрольного цикла удостоверьтесь, что кластер 

эволюционирует в стационарном режиме. 

23. Сохраните отчет и структуру. Проведите срвнительный 

анализ расположения максимумов радиальной функции 

распределения при структурном переходе ГЦК → ГПУ. 

 

 



Рекомендации по оформлению отчета. 

 

Моделирование процессов структурной реорганизации  

нанокластеров с ГЦК или ОЦК типом атомной упаковки  

в различных температурных режимах  

(на примере нанокластера Ni172  или Fe189). 

 

Цель работы: 

 

Заполните таблицу 

 
Температура 

моделирования 

Изображение 

структуры 

Вид радиальной 

функции 

распределения 

Величина 

полной энергии 

связей 

Исходная 

структура 

   

100К    

1000К    

3000К    

 

В выводе опишите свои визуальные наблюдения, оцените 

изменения длин связей в кластере и общей энергии связей. 

Какой процесс был смоделирован? 

 

 

Проведение моделирования процессов структурной  

реорганизации нанокластеров с полной перестройкой типа 

атомной «укладки» в системе  

(на примере ГЦК → ГПУ превращений никеля). 

 

Цель работы: 

 

 

 

 

 

 



Заполните таблицу 

 
Температура 

моделирования 

Изображение 

структуры 

Вид радиальной 

функции 

распределения 

Величина 

полной энергии 

связей 

Исходная 

структура 

   

300К    

200К    

100К    

 

В выводе опишите свои визуальные наблюдения, оцените 

изменения длин связей в кластере и общей энергии связей. Как 

отразился структурный переход ГЦК → ГПУ на расположении 

максимумов радиальной функции распределения? 

 


